Welcome

This user guide describes how to use the Accellion Mobile File Sharing Solution.

If you experience any difficulties when using Accellion, please contact your company’s system administrator.

What’s New

Release 9.8 is a maintenance release.

Release 9.7 includes:

• Remote Wipe for mobile
• Kitepoint 1.5: Add Content Connection option

Release 9.6 includes:

• Organizational edit of the Guide

Release 9.5 includes:

• Bulk Download
• Increased the maximum number of attachments to emails from 10 to 100
• Viewing files with Accellion’s Online Viewer
• Kitepoint – Upload files to Windows File Shares (CIFS/SMB Shares)

Release 9.4 includes:

• Lock/Unlock functionality
• Added Windows File Share (download only)

Release 9.3 includes:

• Kitepoint
• Kitepoint – SharePoint 2007/2010/2013 Sites

Release 9.2.68 includes:

• Schedule Sync
• Select and Sync

Release 9.2.3 includes Workspace Favorites:

• Workspace Favorites

Release 9.2.2 includes an increase in the maximum number of files that can be uploaded.

• Attachments

Release 9.2 includes on-demand syncing for shared corporate files:

• Workspace On-Demand File Sync
Overview of the Accellion Solution

The Accellion Secure Collaboration web user interface offers you the ability to share files and collaborate with others while keeping those files secure, up-to-date, and organized.

Managing Files

The Accellion solution enables you to add, collaborate and share files securely with other stakeholders either in your organization or beyond.

The file management portion of the Accellion solution consists of three tools: kitedrive, kitepoint, and workspaces. Each of these methods of collaboration fills a specific need.

<table>
<thead>
<tr>
<th>kitedrive</th>
<th>kitepoint</th>
<th>workspaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kitedrive is your own personal workspace where you can securely manage your own files, online or offline, over multiple devices.</td>
<td>Kitepoint provides real-time mobile access to files stored in SharePoint and Windows File Shares, behind the firewall, without a VPN.</td>
<td>Workspaces are areas where you can collaborate securely with other users over multiple devices. Users are given different roles defined by the manager of the workspace.</td>
</tr>
<tr>
<td>Sync is automatic and continuous. When you edit a file offline, it syncs automatically when you get back online again.</td>
<td>Sync is not available.</td>
<td>Sync must be performed manually or scheduled.</td>
</tr>
<tr>
<td>Lock/Unlock functionality is not available. Managed by the individual user.</td>
<td>Lock/Unlock feature is available in SharePoint, not in CIFS. Managed by the Accellion administrator.</td>
<td>Lock/Unlock feature is available. Managed by the Accellion administrator.</td>
</tr>
</tbody>
</table>

Sharing Files

In addition to managing your files, Accellion also offers you the ability to share files securely, either via the Accellion interface or through a plugin that connects directly with your Outlook or other email utility. Also available is a SharePoint plugin. Refer to the appropriate plugin user guide for information about plugins.

An optional Administrator-controlled feature includes the ability to access and share your files remotely using a mobile device. Included in this feature is a remote wipe capability if your device is lost or becomes compromised. Contact your Administrator for information about this feature.
Getting Started

This section familiarizes you with the basic layout of the Accellion Secure Collaboration web user interface. This represents the view a typical Standard User would see. Depending on what options the administrator has enabled, not all options and buttons covered here are available.

Logging In

The login screen is where you enter your email address and password to log in and use the Accellion solution. Because Accellion is web-based, be sure that you are connected to the Internet.

The Login Screen has the following fields:

**Forgot Password?** – Click on this if you can’t remember your password. You are prompted for your email address, and a new system-generated password is emailed to you.

**NOTE**: If your Accellion deployment is using an LDAP connection, you are reminded to use your network/email password.

**I don’t have an account yet** – Walks you through the account creation process. If you’re part of the email domain of the Accellion server, you are created as a Standard User. If not, you are created as a Restricted Sender.

**Getting Started?** – This link takes you to the Getting Started Guide.

**Contact Us** – Indicates who you should contact for further assistance.
Home Page

Upon logging in, you are shown the File Manager screen. The **File Manager** tab shows all files currently accessible via your Accellion account, and all of the methods of collaboration available to you: kitedrive, kitepoint, and workspaces.

The **Send** tab is where you compose emails and attach files to be sent. These files are sent as secure links. You can also create draft emails, which can be sent later.
Settings

The Settings link at the top of each page takes you to the Settings page. From here you can modify your account.
Account Info Tab

Click on the **Account Info** tab for information about your account.

**Language**
Change your default language. If none is selected, it defaults to the language the web-browser uses.

**Time Zone**
Select your local time zone. If you observe Daylight Savings, check the box so the time is updated automatically.

**Personal Info**
From here you can edit your password.

**NOTE**: You may not be able to edit your password if your company has integrated Accellion with your local LDAP or Active Directory server. Contact your Accellion Administrator for more information.
Preferences Tab
Click on the Preferences tab for information about your account.

Folder/Large File Applet
This allows you to upload files greater than 2 GB and/or to upload entire folders, and if enabled, to encrypt files.

Editor Formatting
Allows you to set the default format for the Send File tab.

Message Signature
Allows you to create a signature to be automatically added to emails.

Contacts
More information about your stored email addresses and groups are under Contacts.

Contact Name
Shows the list of stored email addresses. These can be edited by clicking the edit button, or removed by clicking the delete button.

Add New Contact
From here you can add commonly used email addresses.

Add New Group
You can create a list of email addresses called a Group. When you type the name of the group in the To: box on the Send File tab, it automatically populates all of the email addresses in the group.
**Help Link**

The Help link at the top of the page takes you to the Help Page.

- **Contact Us**
  Shows whom to contact for assistance with the Accellion product.

- **User Guides**
  View or download the appropriate guide.

- **Downloads**
  Click the appropriate link for additional available downloads

**Sign Out**

Logs you out of Accellion. You are returned to the Login Screen.
File Management

Using Accellion, you can manage your files securely using kitedrive, kitepoint, and workspaces.

Kitedrive

Kitedrive is your own personal workspace where you can securely manage your own files, online or offline, over multiple devices with an installed Accellion app. (Refer to the Accellion’s Mobile Users Guide for more information.) The kitedrive workspace is synchronized automatically and continuously via the cloud, to ensure that any time you open a file, it is the most up-to-date version.

Before you begin syncing your files, you must have kitedrive Sync installed on your computer. Once installed, you can access your personal kitedrive from the desktop icon. For information about kitedrive Sync, contact your Accellion system administrator and refer to the Kitedrive Getting Started Guide.

Options

To view the options about organizing your files, click the kitedrive icon. You will then see the workspaces listed under the kitedrive icon that have already been created.

Next to Options, click the downward arrow on the right. You are shown the options to add a nested workspace within the selected workspace, edit the properties of the selected workspace, download a workspace, or view the Activity Log.
**Add Nested Workspace**

To create a new folder, or workspace, perform the following steps:

1. In the Options drop-down menu, click **Add Nested Workspace**. The Create Nested Workspace popup appears.

   ![Create Nested Workspace Popup](image)

2. Type in the name of the workspace and description.
3. Using the radio buttons, indicate whether you would like to allow or disallow the sync function. More information about Sync is under [Synchronizing Shared Workspaces](#).
4. Click **Create**. The new workspace now appears in the list of workspaces.

**Edit Properties**

You can view and edit the properties of a workspace.

1. In the Options drop-down menu, click **Edit Properties**. The Workspace Properties popup appears.
2. For more information, click **More Properties**.

   ![Workspace Properties Popup](image)

3. If you have made any changes that you would like to change, click **Save Changes**.
   
   **NOTE**: To change any of the options that do not appear as editable, contact your system administrator.
**Download Workspace**

You can download an entire workspace to access to your files while you’re offline (for example, while you’re on an airplane). If the workspace has sync enabled, the files automatically sync when you are back online.

To download a workspace to your computer, perform the following steps:

1. On the Options menu, click **Download Workspace**. A new tab in your browser opens, indicating that you are downloading the folders (workspaces) and the files contained therein via Java Applet. If you do not have Java activated, refer to [Enable Java](#).
2. Follow the prompts to specify where you would like the files to reside on your system.
3. The status bar indicates the status of the download. When the download is complete, you are shown the following screen:

   ![Download via Applet](image1)

4. Click **Close**. The folders and documents now reside in the location where you specified, and if Sync is enabled for that workspace, the files are synced automatically with those files on the Accellion system.

**View Activity Log**

To view all of the activity within the kitedrive workspace, perform the following steps.

1. On the **Options** menu, click **View Activity Log**. The Activity Report popup appears, showing all actions performed in that workspace.
2. To filter the “events” so you can find a particular action, use the drop-down menu next to **Event Type**.

3. Click **Cancel**.

**Managing Files and Nested Workspaces**

Refer to the [Workspaces](#) section of this document. Workspaces act the same, whether they’re nested within kitedrive or other workspaces.

**Send**

To send a file securely, click the checkmark by the file and then click the **Send** button, and follow the directions.

For more information about sending files, refer to the [Sending Files](#) section of this document. The sending files process is the same, whether they’re sent from kitedrive, kitepoint, or other workspaces.
Kitepoint (Optional Licensed Module)

Your Accellion File Manager tab shows a kitepoint icon if kitepoint is licensed. Kitepoint provides access to SharePoint 2007, 2010, and 2013 sites, and to Windows File Shares using the Common Internet File System (CIFS) resources and SMB protocols. Content stores can be accessed either via the web interface or your mobile device.

If kitepoint is enabled, you see a list of SharePoint, CIFS Shares that have been added by your Accellion administrator and to which you have access based on your Active Directory privileges.

SharePoint and Windows / CIFS structures are indicated by the following icons:

- SharePoint – Lock/unlock is supported.
- Windows File Share / CIFS – Lock/unlock is not supported.

You use kitepoint to access files and folders in SharePoint and/or CIFS, but you cannot make any changes to the folder hierarchy. The folder hierarchy should continue to be managed outside of kitepoint. You can, however, add files and versions (where supported) using kitepoint.

**CAUTION:** To avoid overwriting existing files, exercise caution when uploading files with the same name to SharePoint and Windows File Shares.

- **Windows File Shares** kitepoint always overwrites the existing file if the new file has the same file name and extension. Version history is not retained.
- **SharePoint** kitepoint writes a new version if versioning is enabled on the SharePoint Library. kitepoint overwrites the existing file if versioning is disabled.

For more information about SharePoint, CIFS and how to manage files, see your administrator or consult the documentation for those applications.
Add a File

To add a file, perform the following steps:

1. Navigate to the folder into which you want the file to reside.
2. At the top of the page, click Add File. The Add Files dialog box appears.

![Add Files Dialog Box]

3. Using the Location drop-down menu, select the server/controller closest to you for faster uploads.  
   **NOTE:** This only applies in a multi-controller environment; if your organization uses a single controller, disregard this option.
4. Click Choose File to find the file on your system. Use <ctrl> + click to select multiple files.  
   If your file is larger than your Administrator-controlled size limit, click Use Large File/Folder Applet.
5. Click Add. Your file(s) then begins uploading to kitepoint to the location you specified.

Send

To send a file securely, click the checkmark by the file and then click the Send button, and follow the directions.

For more information about sending files, refer to the Sending Files section of this document. The sending files process is the same, whether they’re sent from kitedrive, kitepoint, or other workspaces.
Add Content Connection

When you have access to SharePoint sites or Windows file share that you would like to add to the Accellion server, you can add that site to kitepoint.

1. Click **Add Content Connection**. A new dialog box appears.
2. Type in the **Name**, **Connection Type** (using the drop-down menu), and the **Connection URL**. If you don’t have access to that complete information, contact your Administrator.
   a. If you are not authorized to access the source, you will be prevented from adding the site to kitepoint.
   b. If your credentials to access the site are different than your web login, you will be prompted to enter that information.
3. Click **Add**. The new site appears in the list of content sources available to you.
**Workspaces**

Workspaces act as a folder structure to allow you to organize and share files securely in a collaborative environment. Workspaces support the use of nested workspaces, comments, notification of changes, file tracking, and other features useful for collaborating on group projects.

Click **All** to see all workspaces to which you have access. Top-level workspaces expand to show nested workspaces. Click **Managed** (folders with the 📁 icon) to see all of the workspaces to which you have manager privileges. Click **Favorites** (folders indicated with a star) to see the list of folders marked and you usually frequent.

Top-level workspaces expand to show nested workspaces. Workspaces displayed in the workspace table on the right are sorted alphabetically. When a workspace is selected, the files and nested workspaces are displayed showing files by newest date first.

If a user has access to a nested workspace but not the top level, the top shows as gray in the workspace tree on the left, but you can still open the nested workspace. In the list of workspaces, it is displayed as **Top Level Workspace/Nested Workspace**.

Workspaces are enabled by the administrator of your company's Accellion solution. If you do not see the options listed in this guide, contact your Accellion administrator.
Creating a Workspace

You can create workspaces if you have been assigned workspace creation rights by the administrator. To create a new workspace, log in to your web user account, and click **Workspaces**.

1. To create a new folder at the highest level ("Workspaces"), click the **New Workspace** button. The **Create New Workspace** wizard opens.

To create a new workspace nested within an existing workspace, click **Options** and select **Add Nested Workspace**. The **Create New Workspace** wizard opens.
2 Enter the information on the first page of the wizard:

**Name** – Give your new workspace a name to differentiate it from other workspaces. The name is limited to letters (A-Z, a-z), numbers (0-9), the underscore ( _ ) and hyphen. (-). Each workspace must have a unique name within the Accellion application.

**NOTE:** Nested workspaces can have the same name as their parent workspace, or other nested workspaces.

**Expiration Date** – Determines when the workspace expires.

**Description** – Visible under the workspace title when viewing the workspace.

**Allow Sync / Disallow Sync** – Provides you with the ability to synchronize files in the workspace across users and devices. (For more information about Sync, see [Synchronizing Shared Workspaces](#).)

3 Click **Next**.

4 Enter the email addresses of the users that will have access to the workspace, and click **Add Users**.

![Add Users](image)

**Users** – Enter email addresses of people who should have access to the workspace you are creating. You can set them as:

- **Viewer** – Can only view and download files posted by the Contributor or Manager.
- **Uploader** – Can only upload files, and can only view and download files uploaded by Managers and Contributors (not by other Upload accounts).
- **Contributor** – Can view, upload and comment on files. Can also subscribe to workspace notifications and lock and unlock documents.
- **Manager** – Can view, upload, comment and delete files. Can also subscribe to workspace notifications and lock and unlock documents. Can also add/remove users.

**NOTE:** When you add a user, you must specify which type. If you add several email addresses at once, they are set to the same user type. You can add multiple users by using a comma, semi-colon, or enter after each email address.

**Users List** – At the bottom of the **Add Users** dialog is a list of all current users of that workspace. The creator’s address appears there, as well as any added groups.

**Groups** – When enabled by the administrator, MSAD groups can be added to a workspace. Click the **Groups** tab to the left of the screen.
Select the Group(s) to be added, and then click the **Add Groups** button. The groups are added to the Users list.

The group dropdown contains the option of selecting **All internal users**, that is, all users internal to your organization.

**Anyone after Authentication** (optional) – This option, enabled by your administrator, allows you to open the workspace so any user of the Accellion system can become a Viewer of that workspace after logging in.

**NOTE**: Groups cannot be assigned the role of a Manager.

5. Click **Next**. You are shown the **View Details** page, where you see the details that you have set in the options above. To make changes, click the **Back** button to return to that section.

To send an invitation to the new users, click the associated box and write the text to your email invitation. When the workspace is created, the email will be sent.

6. Click **Finish** to create the workspace. The new workspace is now visible on the **File Manager** screen.
Workspace Options

The options menu allows you to modify the workspace. Click the Options button and the following options appear, depending on your user role in that workspace:

**User Role: Viewer**

- **View Properties** – Shows the properties of the workspace. From here the workspace name and expiration date can be changed, and a description can be added. By clicking the More Properties link, you can view the total size used by the workspace, and any storage quota set by your administrator.

- **Download Workspace** – Allows you to download all files to which you have viewing access within a workspace.

- **Add to Favorites** – Adds the workspace to your list of frequently used workspaces.

**User Role: Contributor**

- **Add Nested Workspace** – Adds a nested workspace to the current one. It has the same managers and users, as well as expiration date as the parent workspace.

- **View Users** – Allows you to view the users and their associated roles in the workspace.

- **View Properties** – Shows the properties of the workspace. From here the workspace name and expiration date can be changed, and a description can be added. By clicking the More Properties link, you can view the total size used by the workspace, and any storage quota set by your administrator.

- **Clone Workspace** – Allows you to make a copy of the workspace, including all users and (if checked) all nested workspaces, but not the files, comments, or notification options. This workspace is created at the same level as the workspace that was cloned.

**User Role: Manager**

- **Add Nested Workspace** – Adds a nested workspace to the current one. It has the same managers and users, as well as expiration date as the parent workspace.

- **Manage Users** – Allows you to manage the users in the workspace.

- **Edit Properties** – Allows you to edit the properties of the workspace. From here the workspace name and expiration date can be changed, and a description can be added. By clicking the More Properties link, you can view the total size used by the workspace, and any storage quota set by your administrator.

- **Clone Workspace** – Allows you to make a copy of the workspace, including all users and (if checked) all nested workspaces, but not the files, comments, or notification options. This workspace is created at the same level as the workspace that was cloned.

- **Download Workspace** – Allows you to download all files to which you have viewing access within a workspace.

- **Remove from Favorites** – Removes the workspace from your list of frequently used workspaces.

- **Send Message** – Allows you to send a message to the users in the workspace.

- **Subscribe for Notifications** – Subscribes to notifications for the workspace.

- **View Activity Log** – Allows you to view the activity log for the workspace.

- **Delete Workspace** – Deletes the workspace.
Download Workspace – Allows you to download the entire contents of a workspace.

Add to Favorites – Adds the workspace to your list of frequently used workspaces.

Send Message – From here you can send an email to the users of that workspace. Either check the box next to the user’s name, or use the Select links at the top of the page to choose your recipients. The View Group Users link displays a new page showing active users that have accessed the workspace via group membership.

Subscribe for Notifications – Allows you to customize what notifications you receive. You can add/remove notifications for Files added or Comments added. Changes made here apply to all nested workspaces as well.

User Role: Manager

Add Nested Workspace – Adds a nested workspace to the current one. It has the same managers and users, as well as expiration date as the parent workspace.

Manage Users – From here you can add or remove users and groups, as well as change their roles.

Add Groups – To add a user, type in their email address and select their role. To add a group, select the Group tab and choose from the list of groups. Once selected, click the Add Groups button to add them to the Users list.

View Group Users link – Clicking this link displays a new page showing active users that have accessed the workspace via group membership.

Roles – You can change the role of a user or group via the pull-down menu next to their name.

NOTE: Group accounts cannot be set to Manager.
– Click to remove a user or group.

**Edit Properties** – Shows the properties of the workspace. From here the workspace name and expiration date can be changed, and a description can be added. By clicking the **More Properties** link, you can view the total size used by the workspace, and any storage quota set by your administrator.

**Clone Workspace** – This allows you to make a copy of the workspace, including all users and (if checked) all nested workspaces, but not the files, comments, or notification options. This workspace is created at the same level as the workspace that was cloned.

**Add to Favorites / Remove from Favorites** – Adds or removes the workspace to your list of frequently used workspaces.

**Send Message** – From here you can send an email to the users of that workspace. Either check the box next to the user’s name, or use the **Select** links at the top of the page to choose your recipients. The **View Group Users** link displays a new page showing active users that have accessed the workspace via group membership.

**Subscribe for Notifications** – Allows you to customize what notifications you receive. You can add/remove notifications for **Files added** or **Comments added**. Changes made here apply to all nested workspaces as well.

**View Activity Log** – Shows a record of all transactions in that workspace. This includes the name of the person who uploaded and downloaded files, added comments, lock/unlock a file, or changed workspace settings. The **Event Type** dropdown can be used to filter and view only the activities that match the selected type. The **Include all nested workspaces** checkbox can be unchecked to show activities only for the selected workspace.

**Delete Workspace** – Deletes the current workspace and all its contents, including files and nested workspaces. A warning dialog appears before the workspace is permanently deleted.
File Options

A number of file options are available when you are a Manager of a workspace. You can add files, nested workspaces, folders, promote a file version, add or reply to comments, download files and folders, and lock/unlock files for editing.

Adding Files and Folders

To add files, navigate to the location where you would like the new file or files to reside. Perform the following steps:

1. Click the Add File button. This brings up a dialog box, offering you options to upload files from your local machine, or from files already uploaded. You also must select the server location where you wish the file to go, using the drop-down menu.

2. Select the file or files you wish to upload and click the Add button. The file now appears in the workspace.

If the File/Large Folder applet has been enabled by your administrator, you have the ability to upload files over 2GB, or entire folders by clicking Use Large File/Folder Applet. Folders are available as a .zip of the uploaded folder.

If this option is not available to you, contact your administrator to have this option enabled.
**Downloading Files**

1. To download a file, click the file itself. A dialog box appears to prompt you to either view or download the file.

2. Click **Download**. A dialog box appears to prompt you to either save the file or open it using the suggested software (for example, if it’s a .doc file, it prompts you to use Microsoft Word).

3. Make your selection.

4. Click **OK**.

You can select individual files as well as multiple files and workspaces; the download creates the same structure on the download, including nested workspaces and files. Note that if your Java applet is not activated, you can only select individual files. See [Enable Java](#) for instructions, or contact your administrator for help if you cannot activate this function.

**Viewing Files**

If you are an Enterprise Mobile or Enterprise Connect customer, Accellion’s Online Viewer allows you to view a file without downloading it. This option, including the limit on the size of the files you can view, is managed by your Accellion administrator.

The files types that are supported by Accellion’s Online Viewer include:

- .bib
- .bmp
- .csv
- .dcm
- .dif
- .doc
- .doc6
- .doc95
- .docx
- .eps
- .html
- .jpg
- .odt
- .pdf
- .pix
- .png
- .pnm
- .pot
- .ppm
- .ppt
- .pptx
- .ps
- .slk
- .svg
- .tga
- .txt
- .vor
- .vor3
- .xhtml
- .xls
- .xlt
- .xlsx
To view the file:

1. Click the file itself. A dialog box appears to prompt you to either view or download the file.

2. Click View. You are then showed a screen indicating that the document is being “prepared” for viewing.

3. When the file is complete, you are shown the following initial view.

4. Using the Home tab, you can zoom, fit to width, navigate throughout the document, select text to a clipboard, or expand to full screen.
5 Using the **Search** tab, you can search for a particular word or series of words. Enter the text in the text box.

Click the search button, and you are then shown the number of results, and you can navigate through the results using the left and right arrows. The search results are highlighted in yellow.

6 Using the **View** tab, you can fit to width, rotate a single page, rotate the entire document, or view the entire document using thumbnails.

7 To exit the Viewer, click the “x” at the upper right of the screen.
**Locking/Unlocking Files**

You can lock and unlock files so others cannot edit the file while you work on it. All user types except Viewers can lock and unlock files. Each file can be unlocked only by the user who locks them, or by the workspace Manager. When a file is locked, other members of the workspace can download, comment on, and view files, but the files cannot be deleted or updated by anyone other than the user who locked the file.

1. To lock or unlock a file, hover the cursor to the right of the name of the document, and a down-arrow appears. Click the arrow.

   ![File List with Lock and Unlock Options]

2. From the menu that appears, select **Lock File** or **Unlock File**. You can lock (and unlock) only one file at a time.

   When a file is locked, a “lock” icon appears next to the name of the document. To find the user who locked the file, hover the cursor to the right of the name of the document, and a popup appears, showing the user’s name.

   **NOTE**: A file does not become unlocked when you upload an edited version of the locked file. When you upload a file you must explicitly unlock it for others to be able to update it.

   ![File List with Lock Options]

   **NOTE**: Managers and your Accellion administrator can unlock any file that has been locked by another user.
**Versioning**

Workspaces allow you to track previous versions of a file. If a file has previous versions, an indicator with blue arrow appears next to it.

![Previous Versions dialog box](image)

Clicking this brings up the **Previous Versions** dialog box, where you can view when the file was uploaded, and who uploaded it. You also have the option to make previous versions the current one, or download previous versions.

![Previous Versions: ImagesForLaunch.gif](image)

When a file is promoted to current, a promotion date is added in the **Previous Versions** dialog box, and the date displayed in the workspaces table is changed to the promotion date.

**Comments**

Comments can be added to files by hovering the cursor over the file and clicking the icon, or by clicking the dropdown menu on the file row. If a file already has comments, click the icon to view them. To hide the comments, click the icon again.

A comment box appears under the file. Type your comment, then click **Add**. Your comment appears under the file, with three new icons:

- 📝 – Edit a comment.
- ✗ – Delete a comment.
- 🔥 – Reply to a comment.

Replies are indented to distinguish them from top-level comments.
Deleting/Recovering Workspaces and Files

When a workspace or file has been deleted, it can still be viewed, recovered, or permanently deleted. The administrator determines how long deleted files can be recovered.

Click this icon to show deleted workspaces and files. They appear grayed out in the workspace area. You can still access the recovery dropdown menu under Options.

– View the properties of the deleted workspace or file, which can be useful for determining whether it should be recovered.

– Recover the selected workspace or file.

– Permanently delete the selected workspace or file.

Click this icon to hide deleted workspaces and files.

Send, Download, Delete

Clicking a file’s checkbox activates the Send, Download, and Delete buttons. This allows you to send a file to another user, download the selected file or files, or remove the selected files. You can select more than one file to perform this action by checking multiple boxes. Click All to select all the files in that workspace. The number in brackets [0] shows the total files selected.

– The link icon shows the static link to the current workspace.

Search Box – Allows you to search titles of workspaces and files (but not comments or file contents).

Sort By – Allows you to sort by Date, File Name, or Owner of the file.
Synchronizing Shared Workspaces

Accellion provides you with the ability to synchronize files in shared workspaces.

Before you begin, you must have kitedrive Sync installed on your computer. Once installed, you can access your personal kitedrive from the desktop icon. For information about kitedrive Sync, contact your Accellion system administrator and refer to the Kitedrive Getting Started Guide.

Allow Sync / Disallow Sync

If you are the manager of the workspace, you can change the Allow Sync / Disallow Sync setting as needed. Note that the setting applies to the workspace, so if you make a change, it affects all users of that workspace. For example, if you change the setting from Allow Sync to Disallow Sync, you disable sync for everyone.

1. Open the shared workspace.
2. From the Options menu, select Edit Properties.
3. Click Allow Sync or Disallow Sync.
4. Click Save Changes.

**NOTE:** If you disallow sync on a nested workspace that is inside kitedrive, the files in the nested workspace remain on the Accellion server; however, they are removed from the kitedrive on your local computer.

When you revert the workspace property to Allow Sync, the files in the nested workspace are recreated.
on your local computer and will sync on demand or can be scheduled. For more information, refer to the
Kitedrive Getting Started Guide.

Desktop Sync Application

This section is specifically for the desktop Sync application. To download this application, check the “welcome”
email from your Accellion Administrator. With this application, users can sync their files with the selected local
workspaces.

Sync Now

To sync the files in your shared workspaces, right-click the kitedrive icon on your taskbar or menu bar, and then
click **Sync Now**. All files in the shared workspaces that have been enabled to Allow Sync are then synchronized.

Schedule Sync

If a workspace is enabled for sync, you can choose on-demand, auto-sync, or scheduled sync.

To sync the files in your shared workspaces, locate the kitedrive menu on your taskbar, and then click **Sync Now**.

1. From the kitedrive menu on your taskbar, click **Preferences**.
2. Click Advanced > More options.
3. Select **Auto sync every** checkbox, and then select the frequency from the drop-down list.
4. Click **OK**.

Files in the selected workspaces that have been enabled to Allow Sync are synchronized according to the auto
sync schedule.
**Sync Status**

On a Window system, the following icons indicate the sync status of a file or workspace.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Kitedrive" /></td>
<td>Kitedrive – a blue kite with check mark indicates that the <strong>file</strong> is in sync.</td>
</tr>
<tr>
<td><img src="image" alt="Kitedrive" /></td>
<td>Kitedrive – a red kite indicates that the file is being synced.</td>
</tr>
<tr>
<td><img src="image" alt="Shared workspace" /></td>
<td>Shared workspace – a green checkmark indicates that the <strong>workspace</strong> is in sync.</td>
</tr>
</tbody>
</table>

**NOTE**: The green checkmark appears only on PC platforms. Macs show the icon without the checkmark.

**Select and Sync**

For syncable workspaces, you can decide which workspaces you want to sync and when.

- If a top-level workspace is not selected, kitedrive sync ignores any syncable workspace nested under it.
- If the top-level workspace is selected but the workspace is not enabled for sync, the files are not downloaded to your local machine.

To sync specific workspaces to your local machine:

1. From the kitedrive menu on your taskbar, click **Preferences**.
2. Click **Advanced > More options**.
3. Select only the workspaces you want to sync to your local machine. The workspace must be set to Allow Sync.
4. Click **OK**.
5. Click **Sync Now**, or wait for the Scheduled Sync to run.
Workspaces that are not selected are not downloaded to your local machine. If you had previously downloaded a workspace but decided not to sync it from the Select Workspaces to Sync dialog box, then the workspace and its files remain on your desktop, but they are not managed by kitedrive sync. A green circle with a checkmark indicates that a workspace is in sync—workspaces that are not being synchronized appear without a sync status icon.

**Syncing Locked Files**

When you sync a file locked by another user, changes made to the file by that user will still be synced to your desktop. The file is then placed in read-only mode on a Windows system (or locked on a Mac). You can unlock and edit the file locally; however, your changes will not be in sync with the Accellion server and the file that is locked there.

Files that you have locked will not be marked as locked by the sync client. You can update and sync these files like other files. To unlock the file, you will need to log into the web client.

When the file is unlocked by the other user on the Accellion system, sync resumes for that file. If you have made local changes and the file on the Accellion server has been updated, a conflict dialog box appears, giving you options to overwrite, or upload your local file.
Sending Files

From the **Send File** tab you can upload and send files securely. The files are sent as secure links, rather than as actual attachments.

![Sending Files](image)

**Inbox**

The first nested folder, **Inbox**, shows a list of messages and files you have received.

To forward a file directly from your inbox:

1. Check the box next to the file and then click **Forward**. You are then directed to the **Send File** page.
2. Fill in the information prompted on the **Send File** page.
3. Click **Send**. You are then shown a confirmation screen indicating to whom the file was sent and what associated files were included.
**Sent Items**

The **Sent Items** folder shows the files you have sent either directly via the Accellion interface, or using the Outlook Plug-In. With the buttons listed here, you can re-send a file, withdraw a file, re-send a message, and see the Sent Items report.

![Sent Items](image)

**Re-Send File** – To re-send a file, check the box next to the file and click **Re-Send File**. This loads the files into the **Send File** page.

**Withdraw File** – If enabled by your administrator, this option allows you to withdraw a previously sent file. This invalidates the link to the attached document that the recipient received, preventing them from downloading the file. This only withdraws the files sent in that email; the associated message is not withdrawn.

**Re-Send Message** – To resend the email message with all attachments, click **Re-Send Message**. This loads the email message and the files into the **Send File** page.

**Sent Items Report** – To view details about whether the attachment has been downloaded and viewed, click the “eye” icon next to the file. A downloadable report appears that indicates the recipient, file, delivery time and the amount of time it took to transfer the file.

**My Files**

The **My Files** section shows all the files you have uploaded to Accellion, either directly via the Accellion web interface, the Outlook Plug-In, or via your mobile device. From here, you can send files, download your files, delete files, view reports on your files, or add files.

![My Files](image)

**Send** To send a file, check the box next to the file name and click **Send**.
**Download**  To download a file, click the file or files and click **Download**. For more information about multiple file download, refer to **Folder/Large File Applet**.

**Delete**  To delete a file entirely from Accellion, select the checkbox of the individual file and click the “x” icon, or check multiple files and click **Delete**. This functionality is managed by your administrator.

**Report**  To view a report that shows the recipient, transfer time, and date downloaded, select the checkbox of the file and click **Report**.

**Add Files**  To add files to Accellion, click the **Add Files** button. You are then walked through the **Add Files** procedure. Note that the added file does not appear in the Workspaces hierarchy; it simply resides in your My Files folder. To add a file to a specific workspace, refer to **Adding Files and Folders**.

**Compose Now**

From the Accellion web user interface, you can email documents securely. Click the **Send File** tab to access the email interface and compose an email.

**To**

Enter the recipient’s email address. Use a comma or semicolon to separate multiple recipients. The maximum number of recipients cannot exceed 100. The auto complete feature shows email addresses used previously. Click **Add CC** and/or **Add BCC**, to add CC and/or BCC recipients.

**Subject and Body Text**

Enter the subject and body text for the email. For more formatting options, click the **Use Rich Text Formatting** link.

**Attachments**

Attachments can include a mix of new uploads and previously sent files. The maximum number of attachments is set by your System Administrator. If you wish to send more than the allowed maximum, bundle multiple attachments within a folder and attach that folder. To increase the number of allowed attachments, contact your System Administrator.

The limit on file size with regular upload is up to 2GB.

**NOTE:** To send folders or files greater than 2GB, use the Outlook Plug-In or refer to the **Folder/Large File Applet section** of this guide.
To attach a file:

1. Click **Choose File** to open the Choose File dialog box for your local system OR click **Choose from File Manager** to select a file already in your account.
2. Highlight the file to send.
3. Click **Open**.
4. Click on **Choose File** again if you wish to upload more files.

To remove a file from an email, select the associated “x”. Depending on company policy, **Send me a copy**, **Notify on Attachment Delivery**, **Encryption**, and **Non Confidential** options may be turned on.

**Folder/Large File Applet**

When enabled by the Accellion administrator, the Folder/Large File applet can be used to:

- Upload files up to 100GB in size
- Upload folders and the files they contain
- Pause/resume an upload session
- Encrypt files

Depending on your company’s policy, the Folder/Large File applet may be in the **Send File** and **Files** pages instead of the normal file selection input boxes.

The Folder/Large File applet can be used by clicking the **Choose File/Folder** button.

Once activated, you are prompted to trust the signed applet from Accellion.

Click **Always**, **Run** or **Yes** to continue.

When using the Folder/Large File applet, the user can select a file or a folder to upload. When a folder is selected, its contents are zipped and uploaded.

**NOTE**: The 2GB total size limitation does not apply to files uploaded using the Folder/Large File applet; therefore very large folders/files can be uploaded using the Folder/Large File applet.

Click the **Browse** button when the applet is loaded, select the desired file or the folder, and click **Open**. To explore the contents of a folder for further selection, double-click the folder. If a folder is selected, it is zipped automatically and added to the email.

When using the Applet, uploads in progress can be paused or resumed. If there is a network outage, you are prompted to continue the upload the next time you next log in.

**Enable Java**

The Folder/Large File and Bulk Download applet requires Java to be installed and enabled. If Java is installed, but the applet does not work, you may need to enable Java from your web browser.

**Internet Explorer**

1. Launch Internet Explorer.
2. On the upper-right corner, click the **Tools** icon.
3 Select **Internet Options**.
4 Select the **Security** tab.
5 Click the **Custom level**... button.

6 Scroll down to **Scripting of Java applets**.
7  Click the **Enable** radio button.
8  Click **OK**.

**Safari**
1  Launch Safari browser.
2  Click Safari and select Preferences.
3  Click the **Security** tab.
4 Check the **Enable Java** and **Enable JavaScript** check boxes.
5 Close the Safari Preferences window.

**Chrome**
1 Launch Google Chrome.
2 In the upper-right corner, click the three-bar **Settings** icon.
3 At the bottom of the page, click **Show Advanced Settings**.
4 Under Privacy, click **Content Settings**. A popup window appears.
5  Under JavaScript, click the **Allow all sites to run JavaScript** button.
6  Click **OK**.

### Additional Options

Other options shown when sending files include the following:

**Send me a copy**

A copy of the email is sent to your email address. This is useful to preserve the email in your local email program after it has been deleted from Accellion.

**Notify on Attachment Delivery**

When the recipient has downloaded the files, you are notified. Click **More** to enter additional email addresses, which are also notified on download of the files. You can enter multiple email addresses, each separated by a comma.

**Encrypt Files**

Files can be encrypted when sent via the Folder/Large File applet. To encrypt files, check the Encryption box. This option is available if your administrator has enabled it.

**Access Control**

You can control who receives the files you are sending. Select one of the following controls:

- Only recipients mentioned above
- Only recipients and internal users
- Anyone after authentication
- Anyone (No authentication)

Note that if you select the final option, anyone with access to this file can forward the file to anyone else, with no record of this transaction having taken place.

**File Expiration**

The default file expiration date is one month from today’s date. If you would like there to be no expiration date, contact your administrator to enable this option.

**Non-Confidential**

Files sent with this option enabled allow recipients to download files without authentication. Note that non-confidential transmissions do not generate return receipts. This option is controlled by the administrator, and may or may not be available.
Creating Drafts

The Accellion web user interface provides you the ability to save drafts of emails you are working on, but are not ready to send. To create a draft, click the Save Now button. You’ll see the title of the email you’re working on appear on the left side of the screen. You can save multiple drafts, and return to them later by clicking on their title.

Uploading Files

While files can be uploaded via the Send File page, the best way to upload many files for sending later is via My Files. From this location, click the Add Files button, browse to the file or files to upload, and shift- or control-click to select multiple files to upload. Once uploaded, you can re-send the file by checking the box next to it, then selecting Send.

Contacts

When a user sends an email via the web interface, the recipient’s email address is saved for faster addressing of future emails. The list of contacts appears when you click Settings. From here, emails can be edited (if an incorrect one was saved) or deleted.

Contacts can also be created from this location.

1. To create a new contract, click Add New Contact. The Create Contact window appears.
2 If the contact requires more than one email address, click **Add more e-mail**...
3 Click **Save**.
4 To edit an email address associated with a contact, click the “pencil” icon. The **Edit Contact** window appears.
5 Make your edits.

If more than one email address should be associated with the contact, click the pencil icon to edit, and then **Add more e-mails**... link to create another email address field.

### Creating Groups

Multiple email addresses can be made into a Group. This allows you to type the name of the Group in the **Send Field To** field to auto-populate it with all addresses in that Group.

1 Click **Add new Group**. The **Create Group** window appears.
2 Name the group, and add email addresses separated with a comma.
3 Click **Save**.

To use Contacts or Groups, start a new email in the **Send File** tab. In the **To:** field, type the name of the group, or an email address, and it automatically shows the available addresses that match. Click the address or Group to add it to the **To:** field.

### Inviting Users

If enabled, Standard and Expert Users can invite others to use Accellion to send files.

1 To invite someone to use Accellion to send files, at the top of the Send File tab at the right, click **Invite**. The **Invite User** window appears.

2 Enter the invitee’s email address, and a personal message to the invite.
3 Click **Invite**. The recipient then receives an invitation email with a link.
4 To complete the registration process, the recipient must click the link in the invitation. If they’re external to your company, they’ll be created as a Restricted Sender, able to send files back to you or any other Standard or Expert user of Accellion.
Request a File Link

When enabled, Standard and Expert Users can send a link to request a file from someone, as well copying others. Recipients of this link can send files back to the requester. Others on the “cc” list are also copied on the response, receiving a link to download the requested file.

1. Click the Request File button to bring up the Request File window.

2. Fill in the fields required. All recipients are able to send files to via the Request File link to the requestor.

3. Click Request File. The recipients receive an email with a link.

4. Upon clicking the link, the recipients are sent to a page where they can send a file back. On this page, the Subject line, To:, and From: addresses cannot be changed. Once sent, the original requestor receives an email with a link to the file.

The amount of times the file can be shared and length of time that the secure download links are valid for is set by the administrator of the Accellion system.

Envelopes

Depending on your company’s policy, the Send File tab may list available envelopes on the left side. Select the envelope you wish to use, and it is displayed as the Send File tab, replacing the default Send File tab.
**User Types**

There are four main types of Accellion users. These types are set by your Accellion administrator. To change your user type, contact your administrator.

- **Recipient** Can only download received files. May not upload or send files. Does not show the **Send File** or **File Manager** tabs.
- **Restricted Sender** Can download, and upload files. Can send files only to Standard or Expert users. A Restricted User is typically an external user.
- **Standard User** Can download, upload, and send files to anyone. A Standard User is typically an internal user.
- **Expert User** Can download, upload, and send files to anyone. They have more control over settings, and can send files that require no authentication. Expert users can only be created by the Accellion administrator. A Restricted User is typically an internal user with special requirements.
Resources

If you have questions that were not answered by this guide, visit our knowledge base at:

https://support.accellion.net/

For support on technical issues, visit our support portal at:

http://www.accellion.com/support